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It is assumed that the user is both familiar and comfortable with the following prior to working

with Microsoft Word:

Prerequisites:

e Using the mouse and the left-click feature
¢ Basic navigation through Microsoft Windows
¢ Basic typing and keyboard commands

Please let the instructor know if you do not meet these prerequisites.

What You Will Learn:

GETTING STARTED

Starting and opening
Microsoft Word

Microsoft Word
components and features

Keyboard functions

Simple tasks in Microsoft
Word

Typing text

Formatting text

Undoing and Redoing

Copying, pasting, cutting
and deleting text

Inserting images and
Clipart

Changing views and setup

Spelling and Grammar
check

Saving documents

Printing documents

Microsoft Word Help

Closing Microsoft Word




USING MICROSOFT WORD

A word processor is a computer program used to create and print text documents that might
otherwise be created using a typewriter. The key advantage of a word processor is its ability to
make changes easily, such as correcting spelling and adding, deleting, formatting and relocating
text. Once created, the document can be printed quickly and saved for later use. In fact, the
document that you are reading now was created using only a small amount of the many features
available in Microsoft Word.

Microsoft Word

Before you get started with Microsoft Word (commonly referred to as Word or MS Word), you
will need to locate and open it on the computer. It may be on your desktop.

From the computer desktop:

1. Double-click on the Word icon =

Go to the Start Menu if the Word icon is not on the desktop:

1. Click = Start = Programs - Microsoft Office > Word*

* Occasionally, Microsoft Word will be available right from the start menu, meaning you should
see the icon right when you click the Start button, and there is no need to navigate to Programs.

MS Word will open a blank page called "Document 1."

This is an image of the upper-left corner
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information: which file you are currently ] . P S U
working on (in this case, "Document 1" S S S
since we have not yet renamed it) and
which program you are using (in this case,
"Microsoft Word.")

This box shows a blinking cursor, ready :
for you to type.




The Title Bar

izl Document1 - MicrosoftWord =10lx|

This is a close-up view of the Title Bar, where file information is located. Notice the three
buttons on the right side, controlling program features.

The Menu Bar
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The Menu Bar is a common sight in almost all Microsoft Windows programs. It features text-
based menus, on which virtually every option available to the user in the entire program is listed.
Each menu expands when clicked (with the left mouse button), offering many options
categorized by specific tasks. This menu is also customizable (for instance, the "Acrobat" menu
on the right of the image above many not be listed on all computer systems) to offer a more
personalized experience for the user.

Standard Toolbar
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Toolbars provide "shortcuts" to commands also found in the Menu Bar. Toolbars are usually
located just below the Menu Bar, and exist to offer another way to perform the same task. As
with all Microsoft Windows programs, there are usually three ways in which to perform every
task in order to suit the user's preferences.

The most commonly used commands in MS Word are also the most accessible. Some of these
commands are:
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New | Open | Save| Print | Preview | Spell-check | Cut | Copy |Paste
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Formatting Toolbar
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The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization and style of the text in the document. For example, (starting from the left side of
the Toolbar) the "Normal" setting dictates the STYLE of your text; the "Times New Roman"
indicates the FONT of your text; the "12" indicates the SIZE of your text; and so on.

This is a sentence that features many differentFONTS.

This is @ sentence that features INAIY different SIZE S

Each one of these options expands into a menu if you left-click on the down-arrow to the right of
the window.

The ""B" will make your text BOLD, the "I" will put it in italics, and the "U" will add an
underline to your text.

Finally, the alignment of the text can be altered using the buttons with the horizontal lines on
them. You can align text

To the LEFT,
In the CENTER,
And to the RIGHT.

The Ruler
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The ruler is generally found below the main toolbars. The ruler tells you where you are on the
page, along with the dimensions of the overall document. Just like a real-world piece of paper,
the default setting is 8.5 x 11 inches, and margins have been incorporated for you. Similar to
most options in MS Word, this is entirely customizable and the user can create document of any
dimension.



The Keyboard

In order to use MS Word effectively, you must input commands using both the mouse and the
keyboard. The above image of a keyboard may closely resemble (if it is not identical to) the
keyboard in front of you; learning just a few certain keys will help to improve your efficiency in
typing as well as present you with more options within the program. The following is a list of
commonly used keys that have special functions in MS Word (key functions can change
depending on which program you are using):

1. Backspace: This key deletes backwards as you type.

2. Delete: This key deletes forwards as you type.

3. Shift: This key, when pressed WITH another key, will perform a secondary function.
4. Spacebar: This key enters a space between words as you type.

5. Tab: This key will force the cursor to indent, or jump forward 10 spaces.

6. Caps Lock: This key will present the capitalized version of each letter key.

7. Control (Ctrl): This key, when pressed WITH another key, performs as shortcut.

8. Enter: This key executes a command (pressed in MS Word, it begins a new line).

9. Number keypad: This is a redundant keypad existing only for user preference.

10. Arrow keys: Like the mouse, these keys are used to navigate through the document.



SIMPLE TASKS IN MICROSOFT WORD
Typing Text:
To enter text, type just as you would if you were using a typewriter.
To capitalize a letter, hold down the SHIFT key wile typing the letter.

Or, press the CAPS LOCK key on the left hand side of your keyboard. You will have to press
the CAPS LOCK key again — once you are done capitalizing — to remove the lock.

You do not need to press ENTER to start a new line — Microsoft Word will automatically wrap
your sentence at the end of the line.

To move the cursor from its position at the end of the your sentence to anywhere else on the page,
use the mouse or the arrow keys to move the cursor where you want the letters or spaces to be
(left-click the mouse to place the cursor) and then type what you want to add — the text will

adjust to include it.

Press ENTER to start a new paragraph (this is sometimes called a "carriage return").
Formatting Text:

Changing the look of what you've written is called "formatting". This can include changing the
text style, size, color, and more.

You can also make bold, underline, or italicize when using MS Word. These features do not
have to be used independently of each other either — in other words, you make bold, underline,
and italicize a single piece of text.

To make text really stand out, you can also combine this with alignment and size to produce a
heading in bold, italics, underlined, sized and centered:

Sale at Bob's Paint Supplies!

In order to apply certain stylistic or other changes to text, you must first HIGHLIGHT the text.
This is a common procedure in Microsoft Windows applications, and like being able to
successfully navigate the mouse around your screen, the ability to highlight well is one that you
want to master.

-continued-



Highlighting text (continued):
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Just as the image above suggests, you can highlight text by placing your cursor (by moving the
mouse) directly to one side of the selection that you are working with. In the case above, the
user wants to highlight the phrase "This is a test" but NOT "to show." In this example, the user
should place the cursor directly to the left of the word "This" and hold down the left-click button
on the mouse.

Then, drag the mouse across the sentence, and a black highlight will follow. The computer now
understands that any and all formatting that you command will ONLY apply to the part of the
sentence that you highlighted (and not "to show," since it is not highlighted).

Suppose we wanted to make the words "This is a test" bold, and leave the rest of the sentence
unformatted. The end result (once you click elsewhere on the screen to remove the highlight
would be this:

This is a test to show

Experimenting with formatting can be fun, and it is an essential tool to master in MS Word. You
can also change the font color by clicking on the appropriate buttons in the Formatting Toolbar.
Experiment and remember — you can always start over with a fresh, new document, so don't
worry about making mistakes! If you do, however, there is always the incredible "UNDO" tool
that is covered in the next section.

Undoing and Redoing
The UNDO and REDO features of Microsoft Windows applications are great tools to rely on
(especially in MS Word). The program will keep a list of the last 25 commands that you have
performed, and it allow for taking "one step" backwards in order to erase what you have just
done.

It is a common thought that life itself show have an UNDO feature. ©

1. Click = Edit = Undo from the Menu Bar to go back one step (up to 25)
2. Click = Edit = Redo from the Menu Bar to go forward on step (up to 25)



Deleting Text:

While typing a document, you make a mistake. Unlike a typewriter, MS Word can delete text on
the screen that leaves no residue — it is as if you never typed on the page in the first place.

A common source of confusion for users is understanding the difference between the "Delete"
key and the "Backspace" key (#1 and #2 on the keyboard map on page 6). Put simply, the
"Backspace" key deletes words to the LEFT of the cursor, and the "Delete" key deletes words to
the RIGHT of the cursor.

This is my awe | some sentence.
BACKSPACE < DELETE

Let's assume that the vertical line dissecting the word "awesome" in the example above is our
cursor. Pressing the "Backspace" key will erase "e," "w," "a" and so on, moving LEFT. The
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"Delete" key will erase "s," "0," "m," and so on, moving RIGHT.
Copying, Cutting and Pasting Text:

In MS Word, you can CUT or COPY text from one are of the document as save that text so it
can be PASTED elsewhere in the document.

When you CUT text, you actually delete it from where you took it, as opposed to COPYING it,
which makes, naturally, a carbon copy of you selection.

When you CUT or COPY text, it is stored on what is known as the CLIPBOARD. The
Clipboard is a tool in MS Word that you can use to stash away cuts and copies of your work, to
be pasted in other places in the document. Once your selection is on the CLIPBOARD, you can
PASTE it as many times as you want!

CUTTING a selection will also make a copy of it, just in case you want to PASTE it elsewhere.
To CUT a selection, first highlight it. Then, click = Edit = Cut from the Menu Bar.

The highlighted text will disappear, as you have just cut it out (but a copy is now on your
clipboard) and MS Word is waiting for you to paste it somewhere else.

-continued-
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Cutting and Copying text (continued):
To PASTE this cut selection somewhere else on the page, place your cursor where you want the
selection to go. Click = Edit - Paste from the menu bar, and it will pop into the place, right
where your cursor is.

To COPY, simply follow those same steps, replacing the CUT command with COPY..

You will notice immediately that the COPY command will not alter your original selection at all,
as it is simply making a copy ofit.

*#* Always remember to hlghllght the selection! MS Word will not allow you to CUT, COPY o

Inserting Images:

With Microsoft Word, you can insert pictures in your document using the Insert command from
the Menu Bar. You can insert pictures from the "'Clip Art" album that comes with the program
or you can insert pictures "'"From a File ..."" that you have previously saved on a disk or
elsewhere on the computer (i.e. the My Documents folder).

Clip Art is a collection of cartoon and computer-generated images that cover a broad array of
commonly needed icons and pictures. These include business, holiday, nature, entertainment,
academic and other themes, along with standard bullets and symbols.

To insert a Clip Art picture in Microsoft Word:

1. Place the cursor (left-click) where you wish to insert you picture in your document.
2. In the Menu Bar, click =2 Insert = Picture = Clip Art

An Insert Clip Art Window will appear. Insert Format Tools Table ‘Window Help A
) ) ) ) ¢ Break... = | Document 1
Navigate the window and make a selection. It will Sl o, —
appear in your document where the cursor is. To resize, : 2R C
grab one of the corners of the image by left-clicking and ,  IndexandTables.. g 7 g5 ”_: E
holding — drag it to size and fine tune the placement. | JM
Fru:um File.

-continued-
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Inserting Images (continued):

You can move the image to another place in the document by left-clicking and holding on the
center of it; drag it to its desired location. More options, such as aligning the image with text (or
special effects like wrapping text around or through an image) can be found by right-clicking the
center, and choosing the format option from the menu.

Occasionally, images are not as they seem. In other words, it may "
look one way in the preview, but come out far different in the
document.

The cursor will change from a typing icon to a double-arrow when
it can be used to resize the image.

From this point, drag the corner to the upper-left corner of the
screen, and the image will grow (note the immediate decrease in & ’ o
quality — images have a very specific size that corresponds with

quality).

You can also insert a photograph or other multimedia from your own files using this same
process. Click = Insert = Picture = From File... and locate the files that you want to include.
MS Word supports many image types, along with movies and other multimedia. Images can also
came directly from a scanner.

Changing Views and Overall Look:

There will be times in which you create documents that don't fit on a standard piece of paper in
its normal dimensions (8.5" by 11").

On the Menu Bar, click = File = Page Setup | File Bie Edic View Insert Format Tools Table

| [ Mew... Chrl+H
From this menu, you can alter the margins, the width, |If; open... b+
height, orientation (portrait = 11" long; landscape = - Close

11" wide), as well as choose from a variety of

) | 5 Chrl+5
templates different types of paper and document styles [ I Seve s
. Save as...
that come with the program.
Save as Web Page...
Versions. ..

Web Page Preview

& Prink Presiew
&h Prirt... Ckrl+P
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2l To change Orientation:

Margins ~ Paper Size | Paper Source I Layaut I

Paper size: i A "Page Setup" window is in the

Letk -

fater = foreground.

‘Widths 11" — _

Heionk: s = = Click on the "Paper Size" tab.

rientation—————————— ——

r o Click once in the circle by the word

"Landscape."
Apply kot IThis section j

Click "OK" and your page settings will be

Default... | (0] 4 I Cancel | Saved'

Your document should now be in a landscape position. If you wish to place it back in a portrait
position, go through the same steps but instead of clicking in the circle besides Landscape, click
in the circle besides Portrait.

Spelling and Grammar Check:

One of the benefits of using a computerized word processor is its ability to recognize, change
and give advice about what you are writing. MS Word has utilities that can check your spelling
and grammar against a master database, and can offer advice on a variety of different
grammatical styles.

MS Word automatically underlines any words that it does not recognize in red, assuming that
they are not spelled right, and green if it does not recognize the grammar, assuming that the
sentence does not make logical sense. For example:

In this case, "quickly brown fox" should read "quick brown fox" and "laziy" should be "lazy." If
you right-click on the word, a menu with pop up with options, including "Ignore" if you do not
want help on this specific phrase.

You can also choose to add words to the MS Word database, if you are going to be typing them
consistently and do not want to flag each one — this is especially useful for names of people as
MS Word will interpret these as misspellings.
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CLOSING MICROSOFT WORD

Saving Documents:

When you finish typing and want to leave the computer, it is important to save your work (even
if you are printing a hard copy — saving should be a reflex). To save you work in MS Word, it is
essential to know WHAT you are trying to save as well as WHERE you are trying to save it.

Click - File > Save on the Menu Bar to get started.

|Ei|e File Edit “iew Insert Format Tools Table

i

CErl+M
Chrl4+2

You can change the filename that Word has chose just by typing a new one in the File name box
at the bottom of the window that appears.

Save in

[:I My Dacuments

%esktop
3 My Computer
‘ 314 Floppy (A H
= Local Disk.{Z:) %
[:I Documents and Settings
[ mletrain
I:"I My Documnents
Q Compact Disc ()
= Local Disk (E:)
&2 common on ‘cscysrv0l' (F:)
2 rilct on'cscwsrvOl' (G
My Mekwork Places
= FTF Locations
¥l addModify FTP Locations

savens 2 x|

o @ ¥ O T

Fil2 name:

IwordZDDDBasic_handoutpilotv1 Jdoc j

H Save I

Save as bype: IWDrd Documnent (*,dac)

j Cancel |

MS Word will automatically save your document with the suffix ".doc" — this is simply a tag that
lets Word know that your work is specific to this program. You do not have to type it — just
highlight what is there (default is "Document1") and write a new file name.

As evident in the diagram above, there are many places in which you can save a file,
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(continued from page 13) some of which are portable and some of which are immobile.

The My Documents folder on your computer's hard drive is a good place to store your
documents. A blank CD (compact disc) is a great portable storage device and can contain a LOT
of data.

It is important to note that every consequent command of SAVE will overwrite your original file,
creating the most up-to-date version. To save multiple versions of your document (for example,
suppose that you wanted to write a five-page paper). You could save five copies {one file
consisting of one page times five} or just one with five pages.

If you want to save the changed document without destroying the original one:

In the Menu Bar, click - File > Save As and give your document a new file name (unique
from the original).

To bring a saved document back up on the screen in MS Word:
Click - File = Open on the Menu Bar

Locate where the file is located (which folder, that is) and click on the filename of the document
you want.

Click - Open.
Printing Documents:
To print your MS Word document:
Click => File = Print on the Menu Bar and a Print window will pop up on the screen.
Click = OK for your document to start printing.

As with all commands in MS Word, you can make changes along the way. From the Print menu,
you can alter how many copies will be made, in what order the pages will be and much more.

Another useful tool is the Print Preview function found alongside the Print command. This
will allow you to look over an exact copy of what will come out of the printer before actually
executing the print command. It is especially useful when experimenting with altered margins
and page dimensions, and can help to conserve paper.
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Finding More Help:

You can get help with MS Word by choosing Microsoft Word Help or Show the Office
Assistant from the Help menu on the main menu bar.

Format Tools Table indow Help|§icrnlgat
3 28 ®f| «) - cu - [2) Microsoft wordHelp  F1

Show the Office Assistant

loman - 12 ~ | B F O

ﬂ' 1. .. K2what'sThist  Shift+F
g g g COffice on the Web

|

About Microsaft Word
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Tutorials are also available on the Internet. Your instructor can help you with locating some of
the resources.

Closing the Program:
Congratulations! You have completed this course in Microsoft Word Basics. As you become
more and more comfortable with the program, it is always helpful to continue to experiment with
options that you come across — sometimes, you can uncover a tool that would have stayed hidden
—and you can improve proficiency by learning the fine details of the program. When you are
finished,
Click - File - Exit from the menu bar
OR
Click on the X in the top right corner of the computer screen.

NOTE: Images and screen captures may differ from those seen on another system.

THIS DOCUMENT IS NOT PROTECTED BY COPYRIGHT.



